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This month we’re in for a 
real treat! Join us for an 
hour of entertainment and 
camera enlightenment as 
YourMacLifeShow.com
co-hosts Shawn and Lesa 
King lead us through a 
short version of the Digital 

Photo Workshop Day 
they’ll be leading 
at Macworld Expo, 
January 2008, “Shoot 
& Edit Like a Pro!”

Whether you’re 
using a digital SLR or a 
point-and-shoot, you’ll 
learn tried and true 
techniques for getting 
better shots in camera, 

plus what to do with them afterwards. Learn 
how to resize images for various uses, and how 
to create some of the mo�  popular photo e� e� s 
around including soft vignettes, collages, par-
tial color, gorgeous grayscale, sele�  retouching 
secrets and more!

Shawn King is the ho�  and executive pro-
ducer of the mo�  popular Macintosh-focused 
broadca�  on the Internet. He has worked in 
the technology se� or for the pa�  20 years and 
been a pioneer in online radio for more than 
13 years. He is dedicated to not only exploring 

(October Meeting continues on Page 7)

At our October 
meeting we were 
treated to a great 
presentation by Jean 
Macdonald, from 
Smile On My Mac,
who make several 
software applications 
that are really easy to 
use and fill the needs 
of many Mac users 

without emptying their wallets. Jean is really 
enthusiastic about these products, and with 
good reason – they work just as advertised.

She spent a lot of time on PDFpen. This is 
a really great application for under $50. With it 
you can add text, annotate, fi ll in forms (even if 
they are not made to be fi llable), highlight and 
lots more. Ju�  take a look below at the features 
which are also li� ed on the Smile On My Mac
Web site.
| Replace text in original PDF with editable text 
blocks (new in 3.0)
| Move, resize, copy and delete images in orig-
inal PDF (new in 3.0)
| Copy and paste rich text; retain fonts and for-
matting when copying from PDFs (new in 3.0)
| Select and copy text across multiple columns 
(new in 3.0)
| Overlay text and images onto PDF (for 
example, sign purchase orders by applying 
signature image)
| Show PDFs in single, facing-page, multi-page, 
and multiple facing-page views
| Insert and remove pages; re-order pages in a 
PDF by drag & drop
| Fill out and save PDF forms
| Create cross-platform fillable PDF forms 
(requires PDFpenPro)
| Scribble your signature or anything else 
directly onto a PDF document
| Use with PageSender for a complete fax turn-
around solution
| Automate PDF manipulations w/AppleScript

Jean showed us examples of how to use 
the various tool included with PDFpen. One of 
my favorites is the Library. This is like a multi-
clipboard or scrapbook that allows you to � ore 
graphics you use regularly. Jean showed a very 
good example of using a scanned signature 

General meeting time schedule:
This meeting is held at The New York Institute of Technology, Salten Hall,
(next to Building 300-Anna Rubin Hall), Old Westbury, Long Island.
Meetings start promptly at 7:00 p.m.
Bradley Q&A 7:00–7:30 p.m.
Beginner’s Q&A 7:00–7:30 p.m.
Featured presentation 7:30–8:20 p.m.
followed by announcements and raffle drawings.
SIG (Special Interest Group) meetings 8:30–10:00 p.m.
Because of the size and  venue for this November meeting, there will be 
no SIGS following the presentation. However, while we have our General 

Meeting Q&A from 7 to 7:30-ish, at the 
same time, we will also have a MacBasic 
Q&A, answering questions that are more 
basic and less intimidating. Look for signs 
just outside the meeting room.

 | In bad weather, call (516) 686-7789.
| The next LIMac board meeting will be at 
the Plainedge Library, (516) 735-4133, 
on Wednesday, July 18th, at 8 p.m.  
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| I have a lot of icons in my Dock I never 
use. If I drag them o�  are they gone for-
ever? Suppose I want to bring them back at 
another time?
Icons in the Dock are like an alias to a real appli-
cation, folder or file. So, if you drag an item 
off the Dock, you are just deleting a pointer to 
the real thing, an alias. Most of the icons in 
the Dock are for programs you can find in your 
Applications folder on your hard drive, perhaps 
in a sub-folder like iWork ’08 orUtilities. To the 
right of the dividing line, you can have folders 
and documents, so that’s a bit harder to guess 
where those came from as the user added them. 
I keep the two database files I use daily there, 
along with a few download folders. You should 
be able to use the Finder/Spotlight to search 
if you can remember what was there. If you 
have the free application, OnyX, you can use 
its Parameters category, Dock tab to ‘Lock the 
icons’ in the Dock from being removed acciden-
tally or by a nasty user.
| I would like to know if Adobe Photoshop CS3
is going to work with Leopard (AKA Mac OS X
10.5 coming out October 26 at 6 P.M.) and when 
will anyone find out.
Adobe’s press materials regarding what’s new in 
Photoshop CS3 (compared to CS2) indicates com-
patibility with Leopard under PowerPC as well 
as Intel based Macintoshs. There is also pub-
lished info that Adobe Digital Editions is “not 
presently supported” under Mac OS 10.5. Adobe 
has only said that they have not received a final 
copy of Leopard with which to test its soft-
ware titles and thus it hasn’t been fully tested 
under Leopard but they will make the neces-
sary adjustments. How long that could take is 
anyone’s guess, but if you keep an eye online 
(versiontracker.com) and do a “Check for updates 
online...” periodically you may see an update 
come along. Then again, when Apple shipped 
Mac OS 10.4 Tiger on April 29, 2005, Photoshop 
CS2 seemed to work OK. The 9.0.2 update 
that came out Sept. 13 of 2006 did address a 
banding printing to inkjet printers issue under 
Mac OS 10.4. Scanner drivers and some plug-ins 
have historically had more trouble than the 
main program itself. If you can wait months 
then I’m sure Photoshop will eventually work 
properly with Leopard, which itself may get an 
(Q&A continues on Page 3.) (November’s Meeting continues on Page 5.)

(November’s Meeting continued from Page 1)

As a not-for-profit organization, we depend 
on the support of members and outside dona-
tions. In fact, we have not sought advertising 
on a regular basis – possibly only twice – since 
1984. Chasing people or friends for money 
has never been anyone’s idea of fun. We have 
always maintained a large enough membership 
thereby gaining continued support and cama-
raderie that keeps members and presenters 
coming back. Our greatest asset is our mem-
bership. As we moved into the 21st century, 
LIMac received a great boost when George 
Canellis, our Vice President, brought us the 
support of Designscapes, an award winning 
landscape design company. Designscapes has 
donated an iPod to our raffle table each month 
for the past two years, and has just promised 
additional iPods thru the year 2008. This 
brings us an element of vitality and energy 
that lasts through the meeting. Everyone is 
hopeful about winning an iPod, and it isn’t 
about the money, it’s about fun, music, audio-
books and anything else you might listen to 
that brings you enjoyment. Thanks, George, 
and thank you Designscapes!

Speaking of audiobooks, I would like to 
take this opportunity to sugge�  my pick of 
the year. Audible.com gives you the ability 
to download an audio version of almo�  any 
literary work and you can li� en to once or a 
dozen times. My problem is that it’s hard to 
read a book on the Long Island Expressway; 
but an audio book lets the miles melt away. 
Once you download something from Audible.
com, it’s yours to read again and again –  and if 
you loose it, you can download another copy. 
On the other hand, hardware and software are 
only good for a couple of years because they 
become outdated. Why didn’t I sugge�  music? 
Well, don’t you already have all the music you 
will ever li� en too? Happy Thanksgiving. 0

(Continues on Page 3)

and having fun with technology personally and 
professionally, but also in helping others under-
� and and use it in their daily lives.

Lesa Snider King is on a mission to teach 
the world to create (and use) beautiful images. 
An honors graduate of the Art In� itute of 
Dallas, she’s been speaking at conferences and 

Ignoring Optical 
Margin Alignment in 
Adobe InDesign CS3:
Optical Margin 
Alignment is a 
wonderful feature 
that makes the 
characters along 
the edges of Frames 
(and Columns within 
those Frames) line 
up optically down 
the page. This helps 
avoid the “in and out” 
look that is the result 
of variations in the 
sizes and shapes of 
various characters. 
It’s a cool concept 
that has always had 
one major drawback. 
Optical Margin 
Alignment, which is 
turned on in the Story 
palette (Type>Story), 
is applied to ENTIRE 
Frames or Stories (all 
text frames that are 
Linked together). In 

 TIP!

The November presentation will be the usual 
second Friday of November, which is 11.9.07 
and the same time, starting at 7PM. It will 
also be at NYIT, however it will be at Salten 
Hall, located next door to the 300 bldg, Use the 
same parking as usual.

Be smart about using Web mail.
By Joe Kissel
Most e-mail providers offer a way for you to 

read your e-mail in a Web browser. This makes it 
convenient to access your messages when you’re 
away from your main computer. However, when 
you’re using a public computer (or someone 
else’s computer) to read your e-mail, you have 
no way of knowing what security measures are 
in place, and you run the risk that someone else 
may be able to access your e-mail — even after 
you’ve left.

When using Web mail in a public place, make 

sure your session is secure. Look for the lock 
icon in your browser window; if it’s not there, 
don’t type your user name or password.

You should also make sure that no one is 
watching when you’re entering your password; 
consider covering the keyboard. If the browser 
offers to remember your password, say no.

Also, if someone has sent you a document as 
an attachment and you want to make sure no 
one else will be able to see it, don’t even down-

load it in the first place. Although you can (and 
should) erase any downloaded files, recovering 
deleted files is often quite easy; someone with 
the right software could later look at a document 
you thought you had erased.

When you’re finished browsing, be sure to 
erase the browsing history and cookies of sites 
you’ve visited. If you don’t know how, check your 
browser’s Help menu. After covering your tracks, 

CS2, there’s no way 
to turn the feature 
on or off for any 
particular paragraph. 
This frame-based 
formatting had 
always been an all-or-
nothing proposition. 
But not any more! In 
CS3, you can turn off 
Optical Alignment for 
any selected para-
graph. Just look under 
the Options menu of 
the Paragraph panel 
and select “Ignore 
Optical Margin” and 
the alignment will be 
turned off for just that 
particular paragraph. 
By making this option 
part of a Paragraph 
Style, you will have 
total control of what 
kinds of paragraphs 
use and don’t use 
Optical Alignment; a 
major step forward!

—Jeff Witchel

mailto:bdichter@optonline.net
mailto:ArchBill@optonline.net
http://www.titanium.free.fr/pgs2/english/onyx_tiger.html
http://www.designscapesny.com/
http://www.audible.com/adbl/site/homepage/AnonHome.jsp?BV_UseBVCookie=Yes
http://www.adobe.com/products/photoshop/family/
http://www.adobe.com/aboutadobe/pressroom/pressmaterials/pdfs/cs3_photoshop_whatsnew.pdf
http://www.adobe.com/products/digitaleditions/systemreqs/
http://www.versiontracker.com/macosx/leopard/
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 TIP!
How to handle 
the Open With 
command:
There are a couple 
of ways to trim down 
your Open With list 
from deleted apps, 
Photoshop plug-ins, 
etc. To purge deleted 
apps, dig into 
Users/username/
Library/Preferences; 
fi nd the fi le com.
AppleLaunchSer-
vices.plist and delete 
it (or rename and 
move it if you’re 
chicken). 

But this plist purge 
won’t free the Open 
With list of plug-ins 
or such that are still 
on your Mac. The only 

(Q&A continues onPage 7)

real escape is to  des-
ignate default apps 
for opening specific 
types of documents. 
For example, find a 
PDF file on your Mac 
and Control-Click its 
icon; select Get Info 
from the Contextual 
menu and use the 
Open With pull-
down to select your 
preferred app for 
opening PDFs, then 
click the Change All 
button to make it the 
default for all PDFs. 
Repeat this ritual 
for other file types 
that you work with 
and you can avoid 
the Open With list 
entirely – save a step 
and Double-Click, or 
use the Contextual 
menu’s Open cßom-
mand instead.

–Mac|Life

update by then, but if you can’t wait that long, 
if you buy a Mac now with Tiger pre-installed, 
you can get the Leopard upgrade for $9.95 and 
install it on another hard drive or partition 
and switch back and forth; Tiger for Photoshop 
and whatever doesn’t work with Leopard, and 
Leopard for whatever else works with the new 
big cat. Photoshop CS3 12.0 and Tiger 10.4.8 - 
10.4.10 have worked together since December 12, 
2006. If you have work to do, I’d stick with that 
pairing for now. Photoshop under Tiger can use 
up to 4GB of memory. That’s the file size limit 
for a Tiff file, PSD files can get up to 2GB in size 
with PS CS3. Mac OS 10.5 supports 64-bit opera-
tions better (now supported in the Application 
layer, not just the UNIX level), but how many 
people have more than 4GB of RAM anyway? 
Only the MacPro (and the discontinued Power 
Mac G5) supports more than 4GB anyway. FYI, 
finding your favorite Photoshop plug-in in a 
updated version that is Universal Binary version 
for Intel based Macs and PS CS3 is the biggest 
concern a Photoshop user has today.
| I turn on Photoshop, scan in an image and 
I want to put in a caption on the bottom, so 
I sele�  the Text tool and as soon as I click an 
insertion point, the whole image turns red. 
Why is that?
You must have turned on the quick mask func-
tion. I’d guess by accident. Just pressing the Q 
key when you are not in the middle of typing 
will switch you into that mode. If you look in 
the toolbox below the foreground and back-
ground color swatches, you will see two icons 
for Standard Mode and Quick Mask Mode 
which will highlight in red as you mouse over 
it as a reminder. The red does not stay when 
the cursor is not over this icon. Hitting the Q 
key again will toggle out of the Quick Mask 
Mode or click the left icon of the pair to switch 
back to the Standard Mode. You’ll find there 
are letter-only shortcuts (not in conjunction 
with the command key) to select most tools in 
the Toolbox. Hover the cursor over each tool to 
familiarize yourself with them.
| When Apple ships Leopard, with that will 
be a Re� ore or a Standalone?
I’d call it a Standalone, as the retail version can 
install the software on any supported hardware. 
(At least a 867MHz G4 with 512MB RAM) It 
installs just the operating system and not any-

thing more. Unlike the restore disc or discs that 
come with a particular model Macintosh, those 
discs can install not just the operating system, 
but also all the other bundled applications as 
well, such as the iLife bundle, encyclopedia, 
games etc. that came on the hard drive. The 
restore procedure usually erases everything left 
on the target volume before putting in the files 
contained on the disc(s). Therefore it should 
only be used on a replacement hard drive. Even 
then, it would be unusual for most people to use 
it because all their own files and updates would 
be replaced by the factory original files. Usually 
a backup copy of a hard drive in daily use is 
backed up for a custom restore later. As people 
try out Leopard, it’s best to backup your hard 
drive to another hard drive and install Leopard
on that to try things out, find out what works 
and what doesn’t. When things don’t work in 
Leopard, you can easily restart on the original 
hard drive and your older Mac OS X. Eventually 
you can adopt Leopard on the internal hard 
drive and use the external drive for Leopard’s
Time Machine backup program.
| You’ve mentioned that Adobe hasn’t cer-
tifi ed Creative Suite 3 with Leopard. What 
about older versions, and for that matter, 
everything else.
Even older versions are less likely to work prop-
erly. The best resource I know of is looking at 
www.versiontracker.com/macosx/leopard/  Here, 
you can download the freeware, shareware and 
commercial updaters that do work with at least 
the development version of Leopard and will 
presumably work with the final shipping ver-
sion. 

I’ll give you an example: The free Opera
Web browser version 9.24 does show Mac OS
10.5 as a sy� em requirement, but 9.23 doesn’t. 
So clearly they have te� ed the newer release 
with Mac OS 10.5 at lea�  the late�  version 
available to the developer as 9.24 was released 
before the final version of Mac OS 10.5 Leopard. 
I imagine there will be a bur�  of more updates 
released after O� . 26 as the developers can te�  
again�  the final Mac OS 10.5.
| In Apple’s Mail, I get gobbledegook in 
some but not all e-mail. What’s all that 
about and how can I fi x it?
This problem is fairly common and can affect 

More of Bradley’s Tech Session 

(Continues from Page 2) 
quit the Web browser and, if possible, restart 

the computer.
Use SSL
Just as a Web site can use SSL to encrypt infor-
mation you type into forms, your e-mail program 
can use SSL to encrypt e-mail sent between your 
computer and your mail server. Using SSL pro-
tects not only your e-mail messages, but also the 
password you use to check your e-mail, against 

interception during transit. Using it is crucial if 
you’re on an unencrypted wireless network; but 
even on a wired network, SSL is a smart choice.

Most ISPs and e-mail providers, including 
.Mac, offer SSL (though interestingly — and trou-
blingly —.Mac does not offer SSL for Web mail). 
Check with your provider to make sure it’s avail-
able; if not, consider a new e-mail provider such 
as FastMail (www .fastmail.fm), which offers 
accounts ranging from free to $40 per year. Then 

turn on SSL in your e-mail client. In Mail, choose 
Mail: Preferences, click on Accounts, and get 
your account. To turn on SSL for incoming 
mail, click on Advanced and select Use SSL. To 
turn on SSL for outgoing mail, click on Account 
Information, click on Server Settings, select Use 
Secure Sockets Layer (SSL), and click on OK. 
Encrypt sensitive messages
Even if your e-mail client uses SSL, the messages 
you send are encrypted only until they reach your 

outgoing mail server. Then they’re transmitted 
in plain text over the Internet (which can include 
hops through numerous other servers), to the 
recipient’s e-mail server, and finally to the 
recipient’s computer. That means your ISP, the 
recipient’s ISP, or anyone in between could con-
ceivably access the contents of your message.
Most of the time, you needn’t worry about this; 
it’s analogous to the fact that someone could 
(Continues on Page 4) 
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The following vendor offers require a top-secret 
user group offer code.  If you are interested in 
any of the following products, please send an 
email to me at gwc11713@optonline.net.
Join the Peachpit Club. 
You can save 25% on all Peachpit books 
by becoming a Peachpit Club Member. 
Membership is free and easy. All you have to do 
is answer a few questions in Peachpit's online 
survey, which you can access from any book 
page. Fill out the survey, you'll save 25% on top 
of the user group savings you receive by entering 
the coupon code at checkout. (You cannot use 
this discount in conjunction with any other 
coupon codes.) Coupon Code: UE-23AA-PEUF 
(case-sensitive) (www.peachpit.com)
Prosoft is dedicated to creating professional 
quality software designed to be easily used by 
both novice and expert users. Prosoft adopts 
the role of being data advocates, fighting to 
preserve data and prevent data loss. Prosoft 

offers a 25% discount to all MUGs using the 
special MUG discount code. Their products 
include: Drive Genius – Maintain, Manage and 
Optimize Your Hard Drive; Picture Rescue 
– Digital Picture Recovery; Data Backup – 
Backup Made Easy; Data Rescue – Emergency 
File Recovery; and TuneTech for iPod® – 
Maintain, Manage and Optimize your iPod.  
(www.prosofteng.com)
O'Reilly Publishing is offering new and better 
discounts. User group members can get a 
discount of 35% off all books and PDFs from 
O'Reilly, No Starch, Paraglyph, PC Publishing, 
Pragmatic Bookshelf, SitePoint or Syngress 
books that are purchased directly from O'Reilly 
by phone or online. Add in free shipping for 
orders over $29.95 and the offer gets even better.
Order from the O'Reilly Store online 
(www.oreilly.com/store/) or by phone at 
1-800-998-9938. Online Code: DSUG

walk up to your mailbox, pull out a letter, open it, 
and read it. It can, and does, happen occasion
ally, but most of us still safely send and receive 
mail — paper and electronic — containing moder-
ately sensitive information without difficulty.

But on the occasion when you can’t take any 
chances — when you must be absolutely certain 
that only you and the intended recipient can read 
the message — you must use encrypted e-mail. 

Doing so requires that both the sender and the 
recipient use the same type of encryption system.

Apple’s Mail can encrypt messages, though 
the procedure to set up encryption is a bit 
involved. It’s easiest if the recipient also uses 
Mail, but some other e-mail programs can also 
decrypt messages encrypted in Mail.

 Another alternative: you and your recipient 
could both use PGP Desktop Home, which sup-
ports a wide variety of e-mail clients on both 

Mac and Windows platforms. The open-source 
alternative Mac GNU Privacy Guard is also com-
patible with PGP.
(Joe Kissell, the senior editor of TidBits & the 
author of Take Control of Passwords in Mac 
OS X. )

Previous IPOD Winners:
Richard Hickerson won the iPod September. 
Bradley Montauk won the iPod in August.

EasyFind 4.0: It’s Easy, It Finds, It’s Freeby. 
By Matt Neuburg (matt@tidbits.com)
Devon technologies has updated EasyFind, an 
important free utility that should be in the 
arsenal of any power user or would-be power user. 

EasyFind is an alternative to Spotlight: it’s 
a utility for finding text on your computer. That 
text could be the name of a file or folder, or part 
of a file’s contents. Unlike Spotlight, EasyFind
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Helen and
Sheldon Gross
shel9@verizon.net

Note: Sore Eyes site 
referrals are for your 
information only. 
Neither the Grosses 
nor LIMac endorse 
any of the sites or 
their products.

Sore Eyes

User Group News
The following vendor offers require a top-secret 
user group offer code.  If you are interested in 
any of the following products, please send an 
email to me at 
Join the Peachpit Club.
You can save 25% on all Peachpit books George Canellis

gwc11713@optonline.
net

(User Group News continues on Page 5)

(Continued from Page 3)

(Continues on Page 5)

Life gets very hectic occasionally. All the things 
we want to do, and all the things we have to 
do seem, at times, to come tumbling down at 
the same instant and crashing into each other. 
At any rate it’s now November meeting time 
and we can report some real progress. We have 
finished digitizing all the miles of eight milli-
meter movies we have taken in the last 50 years. 

Long long ago, we transferred the 50-foot 
reels onto VCR tapes. This took quite a while, 
but at lea�  we are no longer working with short 
bits of tape. Now we transferred the videos 
from the VCR tapes onto the computer which 
are now on the new hard drive. The real editing 
work has yet to be done, but at lea�  they are 
prote� ed from loss.

The economic co�  of this tremendous 
undertaking was not so bad. We did purchase 
a 500GB drive ju�  for � oring the new movies. 
The digitizer I borrowed from a friend who was 
cooperative. The time element was horrendous. 
All the transfers were in real time so a three-
hour videotape took three hours ju�  to digitize. 
I would sugge�  this proje�  only to a retired 
individual, or one who has ju�  planned a long 
� ay-at-home vacation. Many of the longer tapes 
were set up to work while I slept. Of course, 

Shelly bawled me out for forgetting to turn o�  
the computer, but I have to plead not guilty on 
this count. 

The only software needed came with the 
Mac. So far I’ve used iMovie (to transfer the 
digitized results into � orage). Now I’m up to 
the nitty-gritty. Each movie mu�  be cut into 
the appropriate lengths. Poor photography and 
extraneous material mu�  be tossed. Now, with 
the editing, I’m ready to try MovieGate and 
other new programs and will report on this in 
the future.

One great capability with Macs is that the 
movies can be prepared as Quicktime movies 
and sent to friends who � ill use that “other” 
computer sy� em. No real technical skill is 
required to see them this way. Longer movies 
can be burned to a DVD and di� ributed to 
other family members and friends with DVD 
players. Let’s hope that their DVD players are 
compatible with the produ� s created.

The que� ion arises when you purchase 
DVD blanks for � orage. You can buy both +R 
and –R blanks. There’s a que� ion in my mind 
now. Which is mo�  suitable for others? That’s a 
que� ion for Bradley to answer. 

I’ll have to write him and get his reply. 0

mailto:@optonline.net
http://www.peachpit.com
http://www.prosofteng.com
http://www.oreilly.com/store/
mailto:matt@tidbits.com
mailto:shel9@verizon.net
http://www.pgp.com/products/desktop_home/
http://www.limac.org/raffle.html
http://www.apple.com/ilife/imovie/
http://web.mac.com/cducommun/iWeb/MG_English/Home.html
mailto:gwc11713@optonline.net?subject=Nov 07 User Group News
http://devon-technologies.com/products/freeware/index.html
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(User Group News continues from Page 4)
Adam and Tonya Engst of TidBITS are con-
tinuing their sixteen years of supporting user 
groups with a special 10% discount for all orders 
in their new Take Control electronic book series. 
Take Control ebooks provide highly practical, 
tightly focused, inexpensive help from leading 
Macintosh authors. Titles are delivered in PDF 
layout with active links, and are optimized for 
viewing and printing.  The user group code 
to take advantage of this generous offer is
CPN31208MUG.  (www.takecontrolbooks.com)
Do you own or work in a Mac-based small 
business that has grown out of it’s computer-
ized checkbook?  Have you grown tired of 
creating invoices using InDesign or Word?  If 
you think you are ready to move beyond your 
shoebox, MYOB has the right tool for you at 
a great MUG discount.  MYOB US, Inc., the 
leader in Mac small business management, has 
just released MYOB FirstEdge, a new Mac-only 
product that will help you run your business 
quickly and easily. MUG members get $25 off 
the regular price of $99 on First Edge or $100 
off AccountEdge.  (www.myob.com/us/)
Actoris Software’s Xpress Schedule is THE
Macintosh tool for preparing employee work 
schedules. Create better schedules in less time, 
print schedules and even send them to your staff 
by email or text message. Food Cost Manager is 
a complete back office solution for food service 
businesses. Manage your inventory, calculate 
recipe and menu costs, and prepare nutritional 
information for your customers.
Xpress Schedule, regularly $99, is available for 
a special Apple User Group price of $74, and 
Food Cost Manager, regularly $249 is available at 
$185, that’s a 25% discount. Get the user group 
order form at www.actorissoftware.com/mug 
and then e-mail your order to sales@actorissoft-
ware.com
Mushkin Perfect Match products for Apple are 
specifically designed for Mac users. They have 
been creating enhanced memory for more than 
a decade, and believe in providing the highest 
quality products at the best value. Mushkin 
PerfectMatch upgrades are the smart choice. 
They carefully select components and program 
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If you get three people to join LIMac, your next year’s membership will be free. If you get one 
person to join, you will get $12 off; if you get two persons, you will get $24 off. Not a bad deal! 

writing easy to follow, � ep-by-� ep tutorials 
at GraphicReporter.com since 2001. She is also 
a � ock photographer and chief evangeli�  for 
iStockphoto.com and works with David Pogue 
on many proje� s. Lesa is the co-author of 
Photoshop CS3: The Missing Manual (O’Reilly, 
2007), and writes regularly for NAPP, Macworld 
Magazine, Elements Techniques, and Layers.

When they’re not parked in front of their 
Macs, you’ll find Shawn and Lesa perched atop 
their motorcycles, exploring the countryside. 
They live in We� port, CT with two cats.

One copy of Adobe Photoshop Elements 4.0
to be raffled o� , plus various goodies from 

 More of Mac User Groups News

THE LIMAC ON-LINE FORUM/NOVEMBER 2007

(November’s Meeting continues from Page 2)

(Continued on Page 6)

(Continued from Page 4)

(November’s Meeting continues on Page 8)

doesn’t use an index, but finds things the 
old-fashioned way: it hunts through your hard 
disk, directly, file by file and, if you’re looking 
for file contents, byte by byte. Unlike Spotlight, 
EasyFind knows nothing of interpreting file types, 
such as Word documents, to strip them of their 
formatting and examine only the text: it looks 
at the raw data and that’s all. Unlike Spotlight, 
EasyFind knows no limits: there’s no place on 

your hard disk that it won’t search.
Of course, that means EasyFind is rather slow; 

and while it’s working, it may dominate your CPU 
and make it nearly impossible to do any other 
kind of work. No matter. Sometimes, you just 
want to search, and Spotlight is no help. Recently, 
for example, I wanted to look for a certain term 
used in Ruby files in my /usr directory. I’m not 
even sure where all the Ruby files in my /usr 
directory are. Spotlight won’t look there at all. 

EasyFind found all files containing that term in a 
couple of minutes.

EasyFind is free; download it and use it. (It’s 
an 820K download; the application requires Mac 
OS X 10.3.9 or later.) The new update, to version 
4.0, contains some interface revisions making it 
easier to specify a folder you want to search in; 
creation date has been added to the columns of 
information about found files; and multi-word 
searches are said to be handled more accurately.

http://devon-technologies.com/products/
freeware/

Rotate individual PDF 
pages in Preview:
Have you ever downloaded 
a PDF brochure that has 
a mix of portrait and 

landscape pages? In Preview you can use Tools: 

each module to match the manufacturer-
installed memory and provide guaranteed com-
patibility.

 A user group Web � ore is now available 
with the same pricing given to resellers (dis-
counts of 20-40%) insuring the be�  possible 
price for all Mushkin Mac produ� s.
Visit Mushkin's special User Group Store.
(www.mushkin.com/doc/deals/appleusergroups/)
The Mac market has evolved, and so has 
MacAddict. Starting with the February 2007 
issue, MacAddict has become Mac|Life, the new 
Mac magazine that changes all the rules. This 
publication recognizes Apple's dynamic role 
in work, play, and life, and will appeal to core 
Apple users. Features include in-depth how-tos, 
stunning design, and exclusive information. 
Mac|Life is the ultimate magazine about all 
things Apple.
Mac|Life is offering a one-time Apple User 
Group member charter subscription rate of 
$14.95 for 12 issues, a savings of 40% off the 
basic subscription price. (www.maclife.com/
mugsub)
You don't have to put up with unwanted junk 
e-mail. Spamfire from Matterform Media 
removes unwanted commercial and porno-
graphic e-mail from your in-box. protection 
available. Spamfire for just $23, more than 20% 
off the regular price. resource! New subscrip-
tions only. (www.macworld.com/useroffer). 0

http://www.takecontrolbooks.com
http://www.myob.com/us/
http://www.actorissoftware.com/mug
mailto:sales@actorissoftware.com
mailto:sales@actorissoftware.com
http://devon-technologies.com/products/freeware/
http://www.mushkin.com/doc/deals/appleusergroups/
http://www.maclife.com/mugsub
http://www.maclife.com/mugsub
http://www.macworld.com/useroffer
http://devon-technologies.com/products/freeware/index.html
http://db.tidbits.com/
http://www.maclife.com/
http://www.istockphoto.com/introduction.php
http://www.photoshopuser.com/
bdichter
Rectangle



6

Rotate Left (or Rotate Right) to flip the pages 
around, but the problem with that command is 
that it flips all the pages, not just the one you’d 
like to turn. An alternative method is to use the 
toolbar’s Rotate Left and Rotate Right buttons — 
you might have to select View: Customize Toolbar 
to add them if you haven’t done so already. 
However, they too rotate the entire document. So 
here’s how to make Preview rotate just the cur-

rently displayed page in your PDF: hold down the 
Option key before selecting Rotate Left or Rotate 
Right (either the toolbar buttons or the menu 
commands). With the Option key held down, only 
the current page will rotate. (And if you save the 
document, it will be saved with the single page 
rotated.)

–Rob Griffiths

Use Preview to create image files:

By default, Apple’s Preview opens most of the 
PDFs and images you come upon. But that’s 
not all Preview can do — it can actually create 
images, at least in one very specific situation: 
when you have an image on the Clipboard. After 
you’ve copied a graphic, open Preview and press 
Command-N. Preview automatically creates a 
file from the contents of the Clipboard. Use File: 
Save to save the image in the format and loca-
tion of your choosing.

This can be handy, for example, if you use 
Apple’s Keynote and want to create an image 
from a slide. Press Command-C with the slide 
highlighted in the navigator, switch to Preview, 
and press Command-N. Ta-da!— the slide is 
now an image. Also, if you ever grab a portion 
of a screen and send it to the Clipboard (using 
the shortcut Command-Shift-Control-4), and 
then decide you’d rather have the image be a 
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Ilene Strizver
Ilene@thetypestudio.com

Ilene Strizver, 
founder of The 
Type Studio, is a 
typographic consul-
tant, designer, writer 
and specializing 
in all aspects of 
typographic com-
munication, from the 
aesthetic to the tech-
nical. Ilene conducts 
Gourmet Typography 
Training internation-
ally. For more infor-
mation, visit www.
thetypestudio.com.

 Ilene Strizver Answers Some “Type-type” Que� ions

LIMac’s Privacy 
Policy:
General Information 
Collection: LIMac 
acquires mailing and 
e-mail addresses 
from our members 
and no other outside 
sources in order to 
communicate with 
our membership. We 
use this information 
to send out the LIMac 
FORUM and to send 
occasional notices.
Disclosure to Third 
Parties We do not 
disclose mailing 
addresses, e-mail 
addresses or any 
other confi dential 
information to third 
parties.
Questions If you 
have any questions 
concerning LIMac’s 
Privacy Policy, please 
e-mail them to about-
limac@aol.com. 0

(Continued from Page 5)

(Continues on Page 7)

Unlinking Text Boxes
| How can I unlink text boxes without losing or 
disturbing the content? I often want to do this.
Me too! I have separate answers for both Quark-
XPress and InDesign – QuarkXPress: With the 
basic unlink function of XPress, you can’t unlink 
without breaking the content, but with XPert 
Tools Pro (free at www.quark.com/products/
xpress/xtensions/products/xptpro7/), you can use 
the XPertlink tool to unlink text boxes and keep 
the content. Once you’ve installed the plug-in, 
select the text boxes to be unlinked and go to 
Window > XPert TextLink, which will open the 
Textlink palette. InDesign: Open your Scripts 
panel (Window>Automation>Scripts). Look in 
the Application folder and then the JavaScript 
folder. Select the text boxes to be unlinked, click 
on SplitStory.jsx, and voilà!

On the left is Quark’s Textlink palette. Next to it 
is InDesign’s Script menu.

Spacing, Relatively Speaking
| It seems that many Emigre faces, such as 
Tarzana, have loose kerning tables. I have 
become very good at using the Option-Arrow 
keys to kern them. Why this is so?

Your comment about “loose kerning tables” is 
puzzling. I suspect you mean the letter spacing, 
not kerning. Letterfit is the overall spacing, and 
kerning is the addition or reduction of space 
between two characters, such as “LT,” that 
would otherwise have too much (or too little) 
space between them. Tracking is the process of 
adjusting the letterfit.

The ideal letter spacing depends on the size 
of the type you’re setting. Overall spatial rela-
tionships look tighter as type gets smaller, and 
conversely, appear more open as type gets larger. 
For this reason, text fonts should be more 
openly spaced than display type, which can have 
a tighter letterfit.

Before the digital era, when fonts were 
physical obje� s made of lead or wood, found-
ries created each size separately and adju� ed the 
letterfit for each size. With digital fonts, there’s 
usually only one ma� er outline that’s scaled to 
all sizes. A few digital fonts have different ver-
sions, each intended for a specific size range, 
but the va�  majority of fonts come in only one 
version, which mu�  work at any size that you 
specify. Therefore, it’s now up to you to adju�  
the tracking (not kerning) when using a font at 
a very large size, a very small size, or at a size 
that’s out of chara� er for the particular font. 
For example, when you use a text face for head-
lines, you’ll probably need to track it tighter 
than its fa� ory settings.

In these examples set in Emigre Tarzana, 
“Cadmium” is set with default spacing (not 
tracked); the remaining lines, which are all caps, 
are tracked out (made looser than default). 0

On the left is Quark’s Textlink palette. Next to it 

letterfit for each size. With digital fonts, there’s 
usually only one ma� er outline that’s scaled to 
all sizes. A few digital fonts have different ver-
sions, each intended for a specific size range, 
but the va�  majority of fonts come in only one 
version, which mu�  work at any size that you 
specify. Therefore, it’s now up to you to adju�  
the tracking (not kerning) when using a font at 
a very large size, a very small size, or at a size 
that’s out of chara� er for the particular font. 
For example, when you use a text face for head-
lines, you’ll probably need to track it tighter 
than its fa� ory settings.

and no other outside 
sources in order to 
communicate with 
our membership. We 
use this information 
to send out the LIMac 
F
occasional notices.
Disclosure to Third 
Parties 
disclose mailing 
addresses, e-mail 
addresses or any 
other confi dential 
information to third 
parties.In these examples set in Emigre Tarzana, 

If you get three people to join LIMac, your next year’s membership will be free. If you get one 
person to join, you will get $12 off; if you get two persons, you will get $24 off. Not a bad deal! 
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LIMac E-mail 
Address Updates:
Some people have 
changed servers 
(so our e-mails 
bounce back). If 
you have an e-mail 
address and have 
not been getting our 
reminders, please 
e-mail aboutlimac@
aol.com (Donald 
Hennessy) and use 

“LIMac e-mail update” 
as the subject. 

7to ele� ronically sign your documents. You 
can automate PDFpen using AppleScript. For 
example, if you want to add a watermark to each 
page, you can do this with one of the included  
scripts. These include numbering pages, split-
ting the PDF into several parts, and merging 
several PDF’s into one.

An intere� ing feature discovered during the 
presentation, is that PDFpen works very well 
with iWork’s Pages. That really should be no 
surprise, since it can use all of the application 
support built into OS X, such as the color picker. 
If you copy a graphic from a PDF using PDFpen, 
you can pa� e it into a Pages document, and 
it will look perfe� . If you try doing that with 
Adobe Acrobat Reader, the graphic will look 
very low resolution and jaggy. PDFpen is a great 
value for anyone who works with PDF’s.

Next Jean showed us DiscLabel. This is ju�  
what it sounds like – an application to create 
labels for your CD’s and DVD’s. OK, I know 
you’re thinking that you have something to do 
ju�  that. Well, we all probably do, but not as 
slick and versatile as this. Fir�  of all, DiscLabel
supports every label made, as well as Epson R
series printers and LightScribe drives. It has 
great templates – you can purchase and down-
load additional templates, import your own 
graphics, and cu� omize the label any way you 
like. The variations you can create with this pro-
gram are incredible. You can also import photos 
from iPhoto, and album art as well as song li� s 
from iTunes. I personally can’t wait to � art 
experimenting with the program. At $32.95 
this is a real bargain!

La� ly, at my reque� , Jean showed a bit of 
TextExpander. This is an auto-complete utility, 
that will work with any application on your Mac. 
For example, you can make a short snippet of 
text, that when typed, will expand to say, your 
address or e-mail. This can be a great time 
saver. I would however, disable this when using 
Microsoft Word, because Word has its own auto-
complete fun� ion that may make for a confl i� .

Everyone really enjoyed Jean’s presentation 
and the liked the way she casually intera� ed 
with the audience without breaking the fl ow. 
We all look forward to a return visit from her.

Check out all the SmileOnMyMac software 
at: www.smileonmymac.com. 0
–Scott Randell
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file of its own, just switch to Preview and press 
Command-N — there’s no need to grab the 
screenshot again.

—Rob Griffiths

Have it made In the shade with any color in 
Adobe Illustrator CS3:
You need to find shades of a particular color that 
you’re using in an illustration in CS3. Is there 
a quick and easy way to find these shades and 
save them as Swatches?

No problem! Select an object that’s filled 
with your original color and open the new Color 
Guide panel (Window>Color Guide). In the 
Options menu of the panel, select Show Tints/

Shades. The Tints and Shades of your color will 
be in the top row of the Color Variations section 
of the panel with your color in the center, shades 

to the left, and tints to the 
right. If you’d like to change 
the number of Variations, go 
under the Options menu of 

the panel and choose Color Guide Options. In 
the window that opens, you can choose any 
number of Variations from 3 to 20 and press OK. 

The Guide will show up to 20 tints along with 20 
shades of your original color. To save any or all 
of these Variations as Swatches, click on one 
Variation, then Command-Click to select any 
additional Variations, choose Save Colors as 
Swatches from the Options menu. 0

to the left, and tints to the 
right. If you’d like to change 
the number of 
under the 

the panel and choose 

(Q&A continues from Page 3) (October Meeting continues from Page 1)
Safari as well. It’s often a bad font cache but 
sometimes it’s a problem with the encoding of 
the content differing from what the software is 
assuming. Maybe you have a bad font, so use 
Apple’s Font Book to validate your fonts. While 
you’re there, resolve any duplicates. If you have 
Helvetica Fractions or Times Phonetic, disable 
them as they can cause Mail to crash. Disabling 
any fonts from the /System/Library/Fonts/ 
folder can cause problems. I see people disabling 
Helvetica Neue which will cause problems. I sug-
gest you use the free FontNuke available at www.
jamapi.com/pr/fn/ I found it’s often Helvetica 
Oblique by copying and pasting into TextEdit
and examining the font sheet. As for message 
encoding, in Mail 2.1, from the Message menu, 
go to Text Encoding and try something other 
than Automatic. I’ve read a bad Quartz.frame-
work library file can cause sporadic crashes.
| I don’t know why I sometimes get unex-
pe� ed crashes in Safari or Firefox.
Stored in your /Library/Internet Plug-Ins/ are 
your add-ons for all your Web browsers. It’s 
possible you have a damaged or out of date plug-
in. Download and install replacements of all 
you can. Having conflicting plug-ins can be a 
problem, too, like the vlc plug-in which can con-
flict with Flip4Mac WMV Plugin for example. 
Some Web sites can cause your browser to 
crash no matter what you do because they are 
poorly written, particularly those written with 
Microsoft Windows specific technologies. This is 
the only reason you may want to run Windows, 
just for those few Web sites that don’t care 
about the Mac. Any Web browsing within a 
virtualized Windows environment will put that 
environment at risk of a virus. You could have 
problems with cached Web pages and icons. 
You can use the free OnyX, cleaning category, 
Internet tab to delete the caches and Bookmark
icons. Having too many bookmarks can have 
bad side effects, particularly if they are not 
grouped in folders. 0

(Continues from Page 6)

LIMac’s Privacy 
Policy:
General Information 
Collection: LIMac 
acquires mailing and 
e-mail addresses 
from our members 
and no other outside 
sources in order to 
communicate with 
our membership. We 
use this information 
to send out the LIMac 
FORUM and to send 
occasional notices.
Disclosure to Third 
Parties We do not 
disclose mailing 
addresses, e-mail 
addresses or any 
other confi dential 
information to third 
parties.
Questions If you 
have any questions 
concerning LIMac’s 
Privacy Policy, please 
e-mail them to about-
limac@aol.com. 0

The nominating committee slate for 2008:
President: Bill Medlow
Vice President: George W. Canellis
Treasurer: Donald Hennessy
Secretary: Bernard Flicker
Program Coordinator: Rick Matteson
Technical Advisor: Brad Dichter Ellen Phillips

OCT.
NANO

WINNER
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(November’s Meeting continues from Page 5)
iStockphoto, Griffin Technology, and some auto-
graphed Missing Manuals from David Pogue. 
All this is in addition to our iPod raffle!

Make sure to join us for an informative and 
entertaining evening and learn how to shoot 
better photographs and capitalize on one of 
the mo�  useful graphics tools available to the 

“consumer” digital photographer and “amateur” 
graphic arti� . You will not want to miss this 
meeting! 0

–Rick Matteson
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For those of 
you who are 
familiar with 
GoodSearch 
(www.Good
Search.com)
 and have 
been using 

it with LIMac as your charitable or-
ganization of choice, thank you. If 
you’re unfamiliar with GoodSearch it’s 
a search engine where one cent for each 
search will be donated to the non-profit 
organization of your choice. And since 
LIMac is a non-profit organization your 
searching can send some cold, hard cash 
to LIMac. 

Now, GoodSearch has added 
GoodShop which is a click through 
shopping site where LIMac can make 
some really serious money.  Please go 
through GoodShop for all of your holiday 

(and everyday) shopping and LIMac 
can earn upwards  of 25% and more of 
your overall purchase. Over three hun-
dred � ores to choose from, including 
MacConne� ion, Brook� one, Budget 
Car Rental, eBay, Eddie Bauer, Land’s 
End, J&R, Macy’s, Orvis, Target, 
Hotels.com, Apple Store & the Apple 
iTunes Store, as well as Dell. And more 
� ores are signing up for the program 
every day; Amazon.com is coming soon! 
Go to www.GoodSearch.com and click on 
the GoodShop badge. Enter LIMac in the 
field asking “Who do you GoodSearch 
for?”and click onVerify. 

Once verified, you will see the li� . 
Ju�  click on the icons for the various 
� ores and shop ‘till you drop. You get 
the same great prices and LIMac will 
receive a much appreciated donation. 
Bookmark GoodSearch &GoodShop. 
Use them whenever you can! 0

The holidays are coming up and many of 
you are going to be doing some (or mo� ) 
of your shopping online.Wouldn’t it be 
great if LIMac could reap some benefit 

from your online shopping? 
Well, LIMac can!

DAN DANGLO

EXCELLENT!!
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“For his first birthday, 
I’m getting him his own Domain.”

Pay your out-
standing dues now! 
It’s 2007 for a long 
time already!!
Send your $36 
check to: Long 
Island Macintosh 
Users Group, Post 
Office Box 2048, 
Seaford, New York 
11783-0180  

How to better visu-
ally enjoy the Forum:
Your Editor prefers 
you to use Preview 
(with OS X) or 
PostView (www.
metaobject.
com/Products.
html#PostView)
or Adobe Acrobat 
Reader 8.1 for 
reading the Forum.
pdf – excellent pro-
grams that handle.
pdf fi les with visual 
accuracy. (Also read 
their Help fi les to dis-
cover the many tools 
and techniques they 
have available.) 
You’ll be happily 
surprised! 

http://www.GoodSearch.com
http://www.GoodSearch.com
http://www.GoodSearch.com
http://www.metaobject.com/Products.html#PostView
http://www.metaobject.com/Products.html#PostView
http://www.metaobject.com/Products.html#PostView
http://www.metaobject.com/Products.html#PostView
http://www.goodsearch.com/goodshop.aspx
http://www.goodsearch.com/goodshop.aspx
http://www.goodsearch.com/

